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 1 Introducción

No hace mucho, los circuitos eléctricos y electrónicos se construian utilizando componentes de una 
sola función, como por ejemplo interruptores, conmutadores o cruzamientos. 
Con este tipo de componentes no programables, cada circuito estaba cableado para realizar una 
función específica, por ejemplo encender y apagar una lámpara desde distintos lugares. Cambiar la 
función de un circuito exigía modificar el cableado y sustituir componentes.
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Con la aparición de las tecnologías digitales y los microprocesadores, estas funciones, que antes se 
implementaban mediante el cableado y las carácterísticas específicas de cada componente, fueron 
sustituidas por componentes programables que permiten realizar multitud de funciones.
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 1.1 La plataforma Arduino 

El hardware del sistema arduino es una placa base con el microcontrolador, las entradas, salidas y 

tomas de alimentación.

 

1. Microcontrolador (ATmega328) 
2. Conexión a ordenador, USB B, alimentación (5V) y datos. 
3. Salidas/Entradas digitales
4. Entradas análogicas
5. Tomas GND (ground) de tierra (negativo) y tomas de 5 V y 3,3 V
6. Toma de alimentación 6 V a 12 V, para conector de barril
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El microcontrolador es programable desde un ordenador. Para la conexión se utiliza un cable de 
USB A a USB B. 
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La web https://store.arduino.cc/en-es/collections/boards-modules presenta una gran variedad de 
placas Arduino. Para las prácticas propuestas en este documento se utilizará un Arduino modelo 
UNO.
El Arduino UNO dispone de: 

14 pines digitales (pines 0 a 13)
Estos pueden funcionar como entradas o salidas, según se especifique en el programa (sketch) que 
ejecutará el microcontrolador. La entrada o salida digital, reconoce o muestra, dos estados, 5 V o 
0V.    

6 pines anlógicos (pines 0 a 5) para señales de entrada
Una entrada analógica reciben una señal, por ejemplo de tensión, suministradas por un sensor, y la 
convierte en un número entre 0 y 1023 (conversor analógico digital de 10 bit). 

6 pines anlógicos (pines 3, 5, 6, 9, 10 y 11) para señales de salida
Se trata de 6 de los pines digitales, que pueden ser reprogramados como salidas analógicas.

Cuando la placa está conectada a un ordenador mediante el cable USB A/B, es alimentada desde la 
toma USB. Para alimentar la placa sin utilizar un cable USB, se puede utilizar el pin Vin, y se 
recomienda una tensión de 6 V a 12 V. Con una fuente de alimentación que disponga de un conector
de barril de 2,1 mm con polo positivo en el centro (interior), también puede alimentar, utilizando la 
toma para conector de barril.
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 1.2 El software (IDE)

IDE (Integrated Development Environment) es un programa que se debe instalar en el ordenador, 
para crear los programas específicos del Arduino, llamados sketches.

El lenguaje de programación utilizado en los sketches se llama Processing Language 
(www.processing.org).

Los pasos a seguir para la programación del Arduino son los siguientes:

1. Conectar la palca Arduino al puerto USB del ordenador.

2. Escribir un sketch definiendo el funcionamiento de los componentes del circuito.

3. Descargar el sketch al Arduino y esperar unos segundos al reinicio.

4. El Arduino ejecuta el sketch.
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 1.3 Programación de un dispositivo interactivo

Un dispositivo interactivo es un circuito electrónico capaz de percibir el entorno mediante sensores 

(componentes electrónicos que convierten las mediciones del mundo real en señales eléctricas).

El dispositivo procesa la información que obtiene de los sensores y puede reaccionar mediante 

actuadores, componentes electrónicos capaces de convertir una señal eléctrica en una acción física. 

La reacción está determinada por el programa que ejecuta el microcontrolador.

Ejemplos de sensores Ejemplos de actuadores

Sonda de temperatura Dispositivos luminosos (lámparas, LEDs)

Sonda de humedad Pantalla LCD

Detector de gases hidrocarburos Dispositivos acústicos (altavoz, zumbador )

Detector de monoxido de carbono Dispositivos interruptores (transistor, relé)

Sonda Hall (detector de campo magnético) Motor

Detector de final de carrera
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 1.4 Práctica 01: LED intermitente

La primera práctica será montar un circuito con un LED que se encenderá y apagara de forma 

intermitente.

El LED es un componente con polaridad, su contacto más largo se debe conectar al polo positivo y 

el más corto al negativo. En caso contrario bloqueará el paso de la corriente, sin enecenderse.

Además se debe limitar la corriente que circula por el LED a aproximadamente 20 mA. Si se utiliza 

la tensión de alimentación de 5 V disponible en la placa Arduino, la resistencia necesaria para 

limitar la corriente será de al menos R=
E
I
=5

V
0,02

A=250 Ω . Se pueden utilizar resistencias de 

valores bastante más altos, por ejemplo de 1kΩ para proteger el LED.

 En esta práctica, se elige la salida digital 2 para dar señal al LED. El esquema de conecxión es el 

siguiente:

  

Paulino Posada pág. 9 de 42

+

-

DR

Arduino D 2 Arduino GND



Electricidad Unidad Arduino 04/25

Una vez conectados los componentes se crea el código que ejecutará el microcontrolador.

Para ello se abre la IDE, haciendo doble click sobre el icono.

Seleccionar File>New y aparecerá un sketch nuevo

En primer lugar se guardará el nuevo sketch con el nombre “LED_intermitente”. Para ello 

seleccionar File>Save as …
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A continuación se debe introducir el siguiente código:

// Práctica 01 : LED _intermitente

const int LED = 2; // LED recibe el valor 2, que es el número del pin al que está 

// conectado el LED 

void setup() 

{ 

pinMode(LED, OUTPUT);  // define el pin número LED, es decir 2, como salida 

} 

void loop() 

{ 

digitalWrite(LED, HIGH); // enciende el LED 

delay(1000); // espera 1000 milisegundos = 1 s

digitalWrite(LED, LOW); // apaga el LED 

delay(1000); // espera 1000 milisegundos = 1 s

}
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Ahora se comprueba que el ordenador reconoce que la placa Arduino conectada y se puede 

comunicar con ella.

Tools>Port → marcar la opción Arduino 1

Seguidamente TOOLS>Get Board info → muestra los datos de la placa Arduino

La comunicación entre el ordenador y la placa Arduino funciona. La placa ha sido reconocida e 

identificada.
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La imagen muestra la IDE con el primer sketch introducido.
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Una vez introducido el código en la IDE, conviene verificar que no contiene errores. Para verificar 

el código se pulsa sobre el botón de verificación.  

Si el código es correcto, se mostrará el mensaje “Done compiling”

El sketch ha sido compilado, es decir, traducido al lenguaje de máquina que el microcontrolador 

puede interpretar.

Habiendo verificado que el sketch se ha compilado sin errores, es el momento de descargarlo a la 

placa Arduino, pulsando el botón de descarga  

Al descargar un sketch, el Arduino interrumpe el programa que esté ejecutando y se resetea, 

almacenando en la memoria el nuevo sketch que recibe desde la IDE a través del puerto USB. Una 

vez almacenado el sketch, inicia su ejecución.
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Durante la descarga, los LEDs RX y TX situados en la placa Arduino parpadean, indicando que el 

ordenador y la placa Arduino están comunicando. Una vez finalizada la descarga, aparecerá el 

mensaje “Done uploading”. 

Una vez que el Arduino ha sido programado con un sketch, el código queda guardado en la 

memoria y se mantiene en ella, hasta que se descargue un nuevo sketch. La memoria guarda un 

sketch incluso si la placa se desconecta de la alimentación, equivale al disco duro de un ordenador.

Si el sketch ha sido descargado correctamente, el LED conectado debería parpadear en intervalos de

1 s.
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 1.4.1 Estructura de un sketch

El microcontrolador del Arduino ejecuta el sketch de arriba abajo, es decir, la primera línea de 

código es la primera que lee y ejecuta. A continuación ejecuta la segunda línea y así sucesivamente, 

hasta llegar a la última línea. Cada línea de código es una instrucción que debe acabar con el 

símbolo de punto y coma ;

Las instrucciones se agrupan escribiéndolas entre llaves , 

{

instrucción 1;

instrucción 2;

instrucción 3;

}

El sketch de la práctica 01 muestra dos bloques de código entre llaves.

Estos bloques se llaman funciones y los nombres que las identifican son void setup () y void loop ().

Un sketch precisa contener al menos estas dos funciones. La función void setup () siempre precede 

a void loop (), ya que en void setup () se define el comportamiento o funcionamiento de 

componentes del circuito. En la práctica 01, la función void setup () define que el pin 2 es una 

salida, utilizando la instrucción:

pinMode(LED, OUTPUT);

La función void setup se ejecuta una única vez, inicializando los componentes del circuito, para que

a continuación, la función void loop () se repita continuamente, mientras se mantenga alimentado el 

Arduino.
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La función void loop () es la que contiene las instrucciones que se repiten sucesivamente (loop 

significa bucle). En la práctica 01 el bloque de instrucciones correspondiente a void loop () es :

digitalWrite(LED, HIGH); // enciende el LED 

delay(1000); // espera 1000 milisegundos = 1 s

digitalWrite(LED, LOW); // apaga el LED 

delay(1000); // espera 1000 milisegundos = 1 s

A diferencia de un ordenador, el  Arduino no puede ejecutar multiples programas simultáneamente, 

ni finalizar la ejecución de un programa. Al alimentar el Arduino, su programa se ejecuta, la única 

manera de pararlo es desconectando la alimentación, o descargando un nuevo sketch.

Los textos iniciados por // son ignorados por el Arduino, y sirven como comentarios, que aclaran el 

funcionamiento del sketch a quien lo aplique.
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 1.4.2 Análisis del sketch práctica 01

A continuación se analiza el sketch práctica 01 línea a línea.

Línea 1: // Práctica 01 : LED _intermitente

Comentario inicial que identifica el sketch a modo de título.

Línea 2: const int LED = 2; // LED recibe el valor 2, que es el número del pin al que está 

// conectado el LED 

El primer paso en un sketch es definir constante y variables. En este caso se define que la constante 

LED, tiene el valor 2. Una constante siempre mantiene el valor con la que fue definida. Cada vez 

que aparece LED en una instrucción, es sustituido por el número 2.

int significa integer, e identifica a la constante LED como un número entero.

Línea 3: void setup()

Declara la función setup. Esta función inicializa componentes del sistema y sólo se ejecuta una vez.

Línea 4: {

La llave abierta marca el comienzo del bloque de instrucciones de la función setup.

Línea 5: pinMode(LED, OUTPUT);  //define el pin número LED, es decir 2, como salida 

Esta es la única instrucción de la función setup. Define el pin identificado por LED, y LED es el 

número 2, como un pin de salida. 

Al tratarse de una salida digital, el valor del pin 2 puede ser HIGH, que significa que en el pin hay 

una tensión de 5 V respecto a GND, o LOW, que significa que el pin presenta una tensión de 0V 

respecto a GND.
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Pinmode es una función, que precisa las dos constantes LED y OUTPUT como argumentos. Esta 

función asigna al pin identificado por la primera constante, su modo de funcionamiento, que puede 

ser como pin con señal de salida (OUTPUT), o pin con señal de entrada (INPUT).

Línea 6: }

La llave cerrada marca el final del bloque de instrucciones de la función setup.

Línea 7: void loop()

Declara la función loop. Las intrucciones de esta función se ejecutan en bucle (sucesivamente), 

hasta desconectar el Arduino o cargar un nuevo sketch.

Línea 8: {

La llave abierta marca el comienzo del bloque de instrucciones de la función loop.

Línea 9: digitalWrite(LED, HIGH); // enciende el LED 

La función digitalWrite asigna un estado a un pin. En este caso asigna el estado HIGH al pin 

identificado por la constante LED, que es 2. El pin 2 presenta una tensión de 5V respecto a GND. El

diodo se enciende.
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Línea 10: delay(1000); // espera 1000 milisegundos = 1 s

La función delay introduce un tiempo de espera de 1000 milisegundos, antes de que el 

microprocesador pase a ejecutar la siguiente instrucción. El diodo se mantiene encendido 1 s.

Línea 11: digitalWrite(LED, LOW); // apaga el LED 

La función digitalWrite asigna un estado a un pin. En este caso asigna el estado LOW al pin 

identificado por la constante LED, que es 2. El pin 2 presenta una tensión de 0V respecto a GND. El

diodo se apaga.

Línea 12: delay(1000); // espera 1000 milisegundos = 1  

La función delay introduce un tiempo de espera de 1000 milisegundos, antes de que el 

microprocesador pase a ejecutar la siguiente instrucción. El diodo se mantiene apagado 1 s.

Línea 13: }

La llave cerrada marca el final del bloque de instrucciones de la función loop.

Desde esta línea, el microprocesador vuelve a ejecutar la primera instrucción del bloque loop. 

El funcionamiento del sketch práctica 01 se puede resumir como sigue:

• El pin 2 es definido como pin de salida (esto sólo ocure una vez, al inicio del sketch).

• Inicio de la ejecución de las instrucciones en bucle

• El diodo conectado al pin 2 se enciende.

• Pausa de 1 s.

• El diodo conectado al pin 2 se apaga.

• Pausa de 1 s.

• Vuelta al inicio del bucle
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 1.4.3 Mediciones práctica 01

Mide los valores de las tensiones y la corriente.

ER =

ED =

I =

R =

Ejercicio 1:

Crea un sketch que encienda secuencialmente 3 LEDs, con una pausa de 1 segundo entre el 

encendido y apagado.

Dibuja el esquema de montaje de los 3 LEDs. 
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 1.5 Práctica 02: LED encendido por un pulsador 
mientras se mantiene pulsado

En esta práctica se enciende un LED mientras se mantenga accionando un pulsador. A falta de 

pulsador se pueden utilizar dos conductores que se juntan cerrando el circuito.

Con el Arduino se precisará un sensor, que será un pulsador, para dar una señal de entrada, que 

mientras dure, encienda del diodo.

Para conocer el estado del pulsador, se utilizará la función digitalRead ().

La función digitalRead () devuelve el valor 0 en caso de no detectar tensión en el pin que le ha sido 

asignado y el valor 1 en caso de detectar tensión en el pin. Es decir, digitalread () permite saber qué 

es lo que está pasando en el exterior, si la entrada digital está o no recibiendo señal y devuelve un 

valor que se puede guardar en la memoria y ser utilizado por el microcontrolador para determinar 

qué instrucción ejecutar.
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A continuación se debe crear un nuevo sketch, llamado practica_02 e introducir el siguiente código:

// práctica 02: Encender un LED con un pulsador

const int LED = 2;                    // LED recibe el valor 2, que es el número del pin al que 

// está conectado el LED

const int PULSADOR = 5;         // PULSADOR recibe el valor 5, que es el número del 

// pin al que está conectado el pulsador

                                      

int val = 0;                          // val guardará el estado del pulsador, 0 sin señal de 

// tensión, 1 con señal de tensión 

void setup() 

{

pinMode(LED, OUTPUT);       // define el pin número LED, es decir 2, como salida

pinMode(PULSADOR, INPUT);   // define el pin número PULSADOR, es decir 5, como 

// entrada

}

void loop()

{

val = digitalRead(PULSADOR);   // detecta el estado del pulsador (abierto 1 o cerrado 0)

if (val == 1) { digitalWrite(LED, 1); } else  { digitalWrite(LED, 0); }           

// si el valor de val es 1, da salida de 5 V a pin 2 y el diodo se enciende

// si el valor de val es 0, da salida de 0 V a pin 2 y el diodo se apaga

}
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Una vez introducido el código y guardado el sketch como practica_02, se conecta el ordenador con 

el Arduino mediante el cable USB y se descarga el sketch.

 1.5.1 Mediciones práctica 02

Medir tensión en la salida digital 2 con el pulsador accionado y sin accionar.

A continuación se hace un vídeo mostrando el funcionamiento del circuito (encendido y apagado 

del LED y valor de tensión en la salida digital 2, pulsando y sin pulsar). El vídeo debe mandarse a 

pposada@cifpnauticopesquera.es

 1.5.2 If … else

If (condición) { ← esta llave marca el inicio el grupo de instrucciones de if

instrucción 1;

instrucción 2;

}← esta llave marca el final del grupo de instrucciones de if

else {← esta llave marca el inicio el grupo de instrucciones de else

instrucción 3;

instrucción 4;

}← esta llave marca el final del grupo de instrucciones de else

El comando if (si) siempre lleva asociada una condición. Si la condición se cumple, ejecuta las 
instrucciones agrupadas por las llaves correspondientes a if. 

Si la condición no se cumple, salta a else (si no) y se ejecutan las instrucciones agrupadas en las 
llaves correspondientes a else.
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En el sketch de la práctica 02 aparece el siguiente uso del comando if:

if (val == 1) { digitalWrite(LED, 1); } else  { digitalWrite(LED, 0); }

La condición (val == 1) se tiene que cumplir, para que se ejecute la instrucción  

digitalWrite(LED, 1); //enciende el LED, instrucción de if

Si (val == 0), se salta a else, sin ejecutar la instrucción de if y se ejecuta la instrucción de else.

digitalWrite(LED, 0); //apaga el LED, instrucción de else

Para comparar dos valores se utiliza el símbolo ==, mientras que para asignar un valor, por ejemplo 

a una constante o a una variable, se utiliza el símbolo =.

El comando if puede aparecer sin else. En este caso, se ejecutarán las instrucciónes 

correspondientes a if, si se cumple la condición. Si no se cumple, se saltarán las instrucciones de if 

y se ejecutará la instrucción que siga tras la llave que marca el final de if. 
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 1.6 Práctica 03: Medición de tensión 

A diferencia de las entradas digital, que permiten recibir señales de sólo dos valores, la entrada  

analógica dispone de un convesor analógico digital (cad), que mide una tensión de entre 0V y 5V. El

cad devuelve un valor proporcional a la tensión que está recibiendo. Si la tensión en la entrada 

analógica es 0V, el valor qu devuelve el cad es 0, si la tensión es 5V, el cad devuelve el valor 

máximo de 1023. Es decir, el cad mide la tensión entre 0 V y 5V en 1023 fracciones.

La precisión de la medición es de 
5V

1023 fracción
=0,0049

V
fracción

.

La función que devuelve el valor leido por una entrada digital es analogRead(). Si analogRead() 

devuelve el valor 1, significa que en la entrada digital la tensión es de igual o mayor a  0,0049 V  y 

menor a 2⋅0,0049 V=0,0098V . 

En el esquema un potenciometro se utiliza para ajustar un valor de tensión de entre 0V y 5 V.
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El sketch correspondienet es el siguiente.

// Medición de voltaje con entrada analoga A0 

// Voltaje de 0 a 5V

// Resultado visible en  serial monitor

void setup(){

  Serial.begin(9600); //Inicialización de serial monitor

}

void loop(){  

  Serial.print("analogRead= ");

  Serial.println(analogRead(A0));

  

  delay(5000);

} 

Los valores mostrados por Serial Monitor son numeros entre 0 y 1023, proporcionales a la tensión 

en el pin A0.

Ejercicio 1.6-1:

Modifica el sketch de la práctica 3 para que en el Serial Monitor, los datos aparezcan en voltios.

Puedes utilizar variables del tipo integer (números enteros) o float (números decimales).
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Ejercicio 1.6-2:

Utiliza el Arduino para encender o apagar diodos en función de un valor de tensión, variando la 

tensión con un potenciómetro.

Si la tensión es mayor a 1 V, se enciende un led verde, si la tensión es mayor a 2 V, se enciende un 

LED amarillo y si la tensión es mayor a 3 V, se enciende un LED rojo.
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 1.7 Práctica 04: Control de un módulo relé
 
El módulo relé hace la función de conmutador, conectando cargas de hasta 10 A. El accionamiento 

es controlado con una salida digital del Arduino.

Las conexiones del módulo relé son las siguientes.

Paulino Posada pág. 29 de 42
Bornes conexión  a carga (máx 10 A)

común

A

B

IN

GND

VCC

Conexiones a Arduino

Señal del pin digital

Tierra (ground)

Alimentación 5 V



Electricidad Unidad Arduino 04/25

Sin alimentación, el relé mantiene continuidad en tre los bornes común y B.

Al alimentar el módulo relé sin conectar el pin IN a GND, se enciende un LED, sin accionarse el 

relé.  El relé mantiene continuidad entre los bornes común y B. 

Únicamente cuando el pin IN se conecta a GND (0V), el relé cambia su estado, dando continuidad 

entre los bornes común y A. En este caso se encienden ambos LEDs.
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Ejercicio 1.7-1

Conecta al Arduino un pulsador NC y el módulo relé C1, según el siguiente esquema.

Para que la entrada digital D2 detecte correctamente el estado del pulsador, cerrado (5V) o abierto 

(0V), es necesario utilizar una resistencia llamada “pull down”, que conecta D2 con tierra (0V).  

Este es el caso de la resistencia R=10kΩ asegura una tensión suficientemente baja a la entrada 

D2 mientras el contacto se mantenga abierto.

a) Escribe un sketch para que el módulo relé:

• dé continuidad entre las bornas común y A con señal de 0V en D2 (S1 abierto)

• dé continuidad entre las bornas común y B con señal de 5V en D2 (S1 cerrado)

b) Prueba hacer funcionar el pulsador S1 sin la resistencia pull down. Explica qué pasa.

c) Haz un vídeo que muestre el funcionamiento del circuito.

Utiliza las siguientes funciones:

pinMode(pin, INPUT/OUTPUT) asigna a un pin la función de entrada o salida

digitalRead(pin) lee el valor de pin

digitalWrite(pin, 1 o 0) asigna al pin el valor 1 (5V) o 0 (libre de tensión)
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delay(tiempo) detiene el bucle (loop), durante el tiempo indicado en 0,001 s.

if {condición} { Si se cumple la condición, se ejecutan el primer grupo de  

instrucción IF1; instrucciones agrupadas. El segundo grupo de instrucciones,

instrucción IF2; correspondiente a ELSE, no se ejecuta.

} 

else{  Si no se cumple la condición, se ejecuta el segundo grupo de 

instrucción ELSE1; instrucciones (ELSE). El primer grupo no se ejecuta.

instrucción ELSE2; 

}
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Ejercicio 1.7-2

Conecta al Arduino un pulsador NC y los módulos relé C1 y C3, según el siguiente esquema.

Escribe un sketch para que el los módulos relé hagan las siguientes funciones:

Al accionar el pulsador S1, el módulo relé C1 desconecta el motor.

Al accionar el pulsador S2, el módulo relé C3 activa el piloto P1 que indica fase de retardo 

en curso. La fase de retardo debe durar 10 s. Al terminar la fase de retardo, el piloto P1 se 

apaga.
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Ejercicio 1.7-3

Conecta al Arduino un pulsador NC y los módulos relé C1, C2 y C3, según el siguiente esquema.

Escribe un sketch para que el los módulos relé hagan las siguientes funciones:

Al accionar el pulsador S1, el módulo relé C1 desconecta el motor.

Al accionar el pulsador S2, el módulo relé C3 activa el piloto P1 que indica fase de retardo 

en curso. La fase de retardo debe durar 10 s. Al terminar la fase de retardo, el piloto P1 se 

apaga.

Al acabar la fase de retardo, el módulo relé C2 conecta el motor.
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Ejercicio 1.7-4

Modifica el sketch del ejercicio 1.7-3, para que se produzca una desconexión retardada del motor.
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 1.8 Resultados prácticas
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Grupo 5
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 1.9 Soluciones
Ejercicio 1 solución:

Crea un sketch que encienda secuencialmente 3 LEDs, con una pausa de 1 segundo entre el 

encendido y apagado.

Dibuja el esquema de montaje de los 3 LEDs. 
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// Ejercicio 1

// 3 LEDs, se encienden y apagan secuencialmente, con una pausa de 1 segundo entre 

el //encendido y apagado

// Cada LED recibe el valor del pin al que está conectado 

const int LED1 = 1; 

const int LED2 = 2;

const int LED3 = 3;

void setup() 

{ 

pinMode(LED1, OUTPUT);  // define el pin número LED1, es decir 1, como salida 

pinMode(LED2, OUTPUT);  // define el pin número LED2, es decir 2, como salida

pinMode(LED3, OUTPUT);  // define el pin número LED3, es decir 3, como salida  

} 

void loop() 

{ 

digitalWrite(LED1, HIGH); // enciende el LED1 

delay(1000); // espera 1000 milisegundos = 1 s

digitalWrite(LED, LOW); // apaga el LED1 

delay(1000); // espera 1000 milisegundos = 1 s

digitalWrite(LED2, HIGH); // enciende el LED2 

delay(1000); // espera 1000 milisegundos = 1 s
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digitalWrite(LED2, LOW); // apaga el LED2 

delay(1000); // espera 1000 milisegundos = 1 s

digitalWrite(LED3, HIGH); // enciende el LED3 

delay(1000); // espera 1000 milisegundos = 1 s

digitalWrite(LED3, LOW); // apaga el LED3 

delay(1000); // espera 1000 milisegundos = 1 s}

}
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Estos apuntes son una adaptación de “Getting Started with Arduino”, autor Massimo Banzi.
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https://paulinoposada.github.io/web/websites/paulino/books/technical/getting_started_with_arduino_v2.pdf
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